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1 Introduction

A Remittance Advice (RA) provides important information about the processing of claims and
adjustment requests as well as additional financial transactions, such as refunds or recoupment
amounts withheld. ForwardHealth provides electronic RAs to providers through their secure
ForwardHealth Portal accounts when at least one claim, adjustment request, or financial
transaction is processed. An RA is generated regardless of how a claim or adjustment is
submitted (electronically or on paper).

RAs are accessible to providers in a text (.txt) or comma-separated values (CSV) format via their
secure Portal accounts.

Note: The examples in this user guide use Microsoft Office Excel 365. Earlier versions of
Microsoft Office Excel will work with the CSV file; however, files exceeding 65,000 lines may
need to be split into smaller files when downloading. If using another program, the user should
consult the Help function of their specific program for instructions on how to import the file.

1 Introduction 1
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2 Access the Remittance Advices
Page

1. Access the ForwardHealth Portal at https://www.forwardhealth.wi.gov/.

wisconsin gov home sate ogencies wbject direclory deportment of health servic es

ForwardHealth
Wisconsin sorving you
Welcome » February 8, 2022 12:51 PM
Login
Providers Members
« Provider-specific Resources Welcome to the ForwardHealth Portal * Find a Provider
* Become a Pro
* Fee Schedules COVID-19: ForwardHealth Provider News and Resources
. onsin Administrative Code Partners
. dHealth Enroliment Data ¢ Find 3 Provider
rdHealth System Generated Claim Attention: The information included on the ForwardHealth Portal is not intended for * Related Programs and Services
* Adjustments members enrolled or looking to enroll in Wisconsin Medicaid programs. Refer to the ¢ Express Enroliment for Children
« Health Care Enroliment Repartment of Health Services website for member-specific information. « Express Enroliment Change Request
* Provider Revalidation * Waiver Agencies
« Enroliment Tracking Search
* Bed Assessment e-Payment
Medication Therapy Management Case _@ ’% ﬁ Trading Partners
* Management Software 4 * Trading Partner Profile
’ = —— . PEs
Providers Acute and Primary  Adultlong:-Term  Children's Specialty ~ * Companion Guides
Acute and Primary Managed Care Managed Care Care Programs Programs Medication Therapy Management Case
* Related Programs and Services * Management Software Approval Process
« ForwardHealth Enroliment Data & )
« Health Care Enroliment & ﬁ R
Children's Specialty Programs
Irading Partners  Manufacturer Drug Partners Members *-ONELLD S Frigran
Manufacturer Drug Rebate Rebate « Children's port Program
* CMS Medicaid Drug Rebate Program * Katie Beck
* Pharm nformation — « Children's Specialty ?we: Care Plans
S e S S =l

Figure 1 ForwardHealth Portal Page
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2. Click Login. A Sign In box will be displayed.

RofwandEiealih

SignIn

Username

Figure 2 Sign In Box

3. Enter the user's username.

Click Next. A Verify with your password box will be displayed.

ForwardHeulth

Verify with your password

() PORTALUSER1

Password
Forg rd
Bac r

Figure 3 Verify With Your Password Box
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5. Enter the user’s password.

6. Click Verify. The Secure Provider page

wisconsin.gov home state agencles subject dir

interChange

N
ForwardHealth r

Wiseonsin serving you

User Guides | Certification |

You are logged in as a Partner User

**% No rows found ***

About

Home ‘ Search Max Fee Home ‘ Account | Contact Information Online Handbooks ‘ Site Map | iC Functionality ‘

Wisconsin Department of Health Services

will be displayed.

department of health services

Welcome UAT HRPR » August 31, 2016 12:18 PM
Logout

] s

Online Handbooks

ForwardHealth Updates

Max Fee Schedules

Partner Links

Partner Request Access

Partner Portal User Guide

Wisconsin Well Woman Program
Policy and Procedure Manual

Express Enrollment for Children
Express Enrollment Change
Request

File Upload To Portal
File Uploaded To Portal Search

| Contsct | Disclaimer | Privacy Notice

UAT UAT_WIPortal2_M5514
Session expires in: 00:25:38

Figure 4 Secure Provider Page
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7. Click Remittance Advices on the main menu at the top of the page. The Remittance Advices
page will be displayed.

Note: The Remittance Advices option is displayed for administrative accounts or for clerk
accounts that have been assigned the Remittance Advice role. For information about adding
the Remittance Advice role to a clerk account, refer to the ForwardHealth Provider Portal
Account User Guide, which is located on the Portal User Guides page of the Portal.

Remittance Advices

ForwardHealth offers providers and MCOs two different options for obtaining their remittance advices
electronically. From this page, users will be able to select the electronic RA format that best suits their

needs.

Text Report Format (.txt)

Use the following link to access remittance advices in text format. Users will be able to select which
specific RA they would like to download or view. Text report formatted remittances are available for
the past 121 days.

+« Download or view remittance advices in a text {.txt) report format

Comma-Separated-Values Format (.csv)

Use the following links to access remittance advices in CSV format. Users will be able to select
which specific RA they would like to download. Users will also be able to choose which sections of
the RA they would like to include in the download file. & provider or MCOs last 10 remittance
advices will be available in CSV format.

s« Download remittance advices in a CSV (.csv) report format

e View the RA User Guide

e View the CSV file User Guide
s View EOB codes and descriptions
The official version of the remittance advices will continue to be maintained within the ForwardHealth

databases.

i, -
vaple, oo G B b M R i F—

Figure 5 Remittance Advices Page
The Remittance Advices page displays the following links:

e Download or view remittance advices in a text (.txt) report format—Allows users to view
or download .txt copies of RAs from the past 121 days.

e Download remittance advices in a CSV (.csv) report format—Allows users to download
their ten most recent RAs in a CSV format.

e View the RA User Guide—Allows users to access basic information about using RA
functionality on the Portal.

2 Access the Remittance Advices Page 5
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e View the CSV file User Guide—Allows users to access basic information about using the
CSV file containing their RA information. The CSV format is accepted by several computer
software programs, including Microsoft Office Excel and Microsoft Office Access.

e View EOB codes and descriptions—Allows users to access a list of Explanation of Benefits
(EOB) codes and descriptions. A list of all the EOB codes used for an RA will be displayed
at the end of the RA. In .txt files, the EOB codes and their descriptions will be listed. In
CSV files, only the EOB codes will be listed.

Note: Users who change their Portal account password should not access their RAs for at
least 30 minutes after the password change.

2 Access the Remittance Advices Page 6
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3 View Remittance Advices in Text
Report Format

1. Inthe “Text Report Format (.txt)” section, click Download or view remittance advices in a text
(.txt) report format.

Text Report Format (.txt)

Use the following link to access remittance advices in text format. Users will be able to select which
specific RA they would like to download or view. Text report formatted remittances are available for
the past 121 days.

+ Download or view remittance advices in a text (.txt) report format

g gt b It s ran i APyt P it

Figure 6 Text Report Format (.txt) Section

The OnBase Document Viewer showing the most recent RAs for the logged in account will
open in a separate window.

|4
LB & hitp://172.30.1033/WiPortal2/Subsystem/ SW/ View
File Edit View Favorites Tools Help
x @Convert v [EHSelect x & Snagt B &
DocumentID Description
1460090 11/12/2015 - CRA-BANN-R: Remittance Advices - PHI - TXIX - 1667378 - 00000000 MCD
— == —— T  — —

Figure 7 OnBase Document Viewer

3 View Remittance Advices in Text Report Format 7
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2. Click the RA the user wishes to view. A File Download window will be displayed.

I

Do you

=

want to open or save this file?

MName: OnBaseTempFile_201108301100550860_ 944050 tat
Type: Text Document, 5.92KB
From: 192.57.192.139

Cpen ][ Save l[ Cancel J

a

While files from the Intemet can be useful, some files can potentially

harm your computer. f you do not trust the source, do not open ar
save this file. What 's the risk?

Figure 8 File Download Window

3. Choose to either open or save the RA.

Click Open to view the RA without saving. The RA text report will be displayed in a
separate window. Refer to the example RA text report below.

3 View Remittance Advices in Text Report Format 8
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e C(Click Save to save the RA for record-keeping purposes. A Save As window will be
displayed.

| ‘ Organize v o= Views ~ I New Folder

Esintatanks Name Size Type Date modified B
B Documents U |\ Shared Folder l Public
More » l l

Folders v \ W] & S ";i( Network
{ !&f omputer ~ A orl
Bl Desktop o~ S "

m

File name: OnBaseTempFile_201108301100550860_944050.b¢t

Save as type: [Text Document

'~ Hide Folders [ =

3

Figure 9 Save As Window

o Choose a location on the computer or network to save the RA.

3 View Remittance Advices in Text Report Format 9
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o Click Save. The Download Complete window will be displayed.

Download complete _ E@g1

Vi 4
=

Download Complete

OnBaseDocViewer.aspx from 192,57.192,139

Downloaded: 6.92KB in 1sec
Download to:
Transfer rate: 6.52KB/Sec

..\OnBaseTempFile_201108301100550860_54405..

[ Cloze this dizlog bex when download completes

Open

] [Ope.-n Folder ] [

Close ]

Figure 10 Download Complete Window

o Click Open.

The RA text report will be displayed in a separate browser window.

| OnBaseTempFile 201603041321010311 1460090.¢ - Notepad oo 0
File Edit Format View Help
REPORT:  CRA-CDDN-R FORWARDHEALTH INTERCHANGE DATE: 11/12/2015 .
RA#: 1667378 WISCONSIN FORWARDHEALTH PAGE: 2
PAYER:  TXIX PROVIDER REMITTANCE ADVICE
COMPOUND DRUG CLAIMS DENIED
GROUP HEALTHCOOPERATIVE OF PAYEE ID 69000130 MCD
PO BOX 88619 NPT
SOUTH CENTRAL WISCON CHECK/EFT NUMBER 000000000
MILWAUKEE, WI 53288 PAYMENT DATE 11/13/2015 |E
--ICN-- RX NO. PRESCRIBING PROV UD DAW SUB LVL EFF SERVICE DATE  QUANTITY BILLED AMOUNT OTH INS AMT  SPENDDOWN
MEMBER NAME: ABC SMIT MEMBER NO.: 0123456789
2215316001002 3121231  NPI 1770599953 o 0 111111 2.000 2.00 0.00 0.00
HEADER EOBS: 1392
METRIC BILLED
NDC DESCRIPTION qQry AMOUNT PA NUMBER DETAIL EOES
00781703939 TRIAMCINOLONE ACETONIDE 1.000 1. 1144
1.000 1.00 1144
TOTAL COMPOUND DRUG CLAIMS DENIED: 2.00 0.00 0.00
TOTAL NO. DENIED: 1
REPORT:  CRA-TRAN-R FORWARDHEALTH INTERCHANGE DATE: 11,/12/2015
RA#: 1667378 WISCONSIN FORWARDHEALTH PAGE : 3
PAYER:  TXIX PROVIDER REMITTANCE ADVICE
FINANCIAL TRANSACTIONS
GROUP HEALTHCOOPERATIVE OF PAYEE ID 69000130 MCD
PO BOX 88619 NPT
SOUTH CENTRAL WISCON CHECK/EFT NUMBER 000000000
MILWAUKEE, WI 53288 PAYMENT DATE 11/13/2015
——————————————— NON-CLAIM SPECIFIC PAYOUTS TO PAYEE--—----—---————
TRANSACTION PAYOUT REASON SERVICE DATE RELATED
NUMBER AMOUNT CODE FROM THRU  PROVIDER ID
4| mn 3

Figure 11 RA Text Report

The RA text report will usually open in Notepad, the default text viewing and editing program
for most computers; however, the report may be opened in any text program.

3 View Remittance Advices in Text Report Format 10
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3.1 Format the Remittance Advices Text File

To properly view and print the RA text file, the user may need to make some formatting
adjustments. These adjustments can be made in any text editing program; however, the
examples below use Notepad.

1.

From the main menu at the top of the browser window, click Format. The Format drop-down
menu will be displayed.

Format | View Help
Word Wrap

Font... t&"

Figure 12 Format Drop-Down Menu

Ensure that there is not a checkmark next to Word Wrap. If there is a checkmark next to
Word Wrap, select Word Wrap to uncheck the option.

From the Format drop-down menu, select Font.

Format | View Help
Word Wrap

Font... [.}

Figure 13 Format Drop-Down Menu

The Font window will open.

T
Font —
T
Faont: Font style: Size:
Lucida Caonsole Regular QK
Lucida [ - I -
(} Lucida Fax ttalic 9 =
() Lucida Handwriting Bold 0 |i|
(} Lucida Sans []{ |Bold kalic 1
(} Lucida Sans Typewrite 12
(} Lucida Sans Unicode 14
()} Luz5ans Bold & 16 &
Sample
AdBbYyZz
Script:
Westem -

. Teeee———— meaaa——. e oaas

Figure 14 Font Window

3 View Remittance Advices in Text Report Format 11
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4. Select Lucida Console as the font type if it is not already selected.

Note: You may select any non-proportional (fixed-width) font type. A proportional font type
such as Times New Roman has varying character widths and will not allow the text file to be
properly aligned.

5. Change the Size to 8.
6. Click OK.

7. From the main menu at the top of the browser window, click File.

File | Edit Format View Help
Mew Ctrl+M
Open... Ctrl+0
Save Ctrl+5
Save As...

Page Setup...
Print... l’\‘? Ctrl+P
Exit

Figure 15 File Drop-Down Menu

8. From the File drop-down menu, select Page Setup. The Page Setup window will open.

Figure 16 Page Setup Window

3 View Remittance Advices in Text Report Format 12
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9. Under Orientation, click Landscape.
10. Click OK.
11. To print the file, select Print from the File drop-down menu.

If the user wishes to have numbered pages, open the RA in a word processing program such
as Microsoft Office Word and, after making the same formatting changes as detailed above
for the text file, add page numbers to the RA.

3 View Remittance Advices in Text Report Format 13
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4 Download Remittance Advices in a
Comma-Separated Values Report
Format

A CSV file is a specially formatted plain text file which stores information in a format that can be
easily imported into a spreadsheet or database.

1. From the “Comma-Separated-Values Format (.csv)” section of the Remittance Advices page,
click Download remittance advices in a CSV (.csv) report format.

Comma-Separated-Values Format (.csv)

Use the following links to access remittance advices in CSV format. Users will be able to select
which specific RA they would like to download. Users will also be able to choose which sections of
the RA they would like to include in the download file. A provider or MCOs last 10 remittance
advices will be available in C5V format.

« Download remittance advices in a CSVY (.csv) report format

+ View the RA User Guide

« View the CSV file User Guide

* View EQOB codes and descriptions

Figure 17 Comma-Separated-Values Format (.csv) Section

4 Download Remittance Advices in a Comma-Separated
Values Report Format 14
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The Download RA page will be displayed.

[oomooin o]

ForwardHealth offers the 10 latest Remittance Advices (RAs) for download in 3 Comma-Separated-Values (CSV)
format. Users have the option to download the full RA or to select specific sections to include in the CSV file.

To download an RA in CSV format:

e Select an RA to download from the list below
e Select "All" to download the full RA
—or-

Select the specific RA section you would like included in the file

s Click submit and save (or open) the CSV.

Remittance Advices

RA Number RA Date Check/EFT Mumber Banner Messages
311952 06/22/2010 000000000 7 messages
311700 05/17/2010 000000000

311683 05/13/2010 000055667

311590 05/03/2010 000055611
311028 03/08/2010 000055383
310926 02/25/2010 000055332
310882 02/15/2010 000055319

Select an RA section to download:

[ i [ summary [[IMedicare Crossowver - Professional Claims
[[lPayment [[]1npatient Claims [[IMedicare Crossover - Institutional Claims
[l Payment Hold [“]outpatient Claims [[l Compound Drug Claims
[[1service Codes [C|Professional Service Claims [|Drug Claims
[CIFinancial Transactions []Long Term Care Claims [IDental Claims
Submit Cancel

Figure 18 Download RA Page
On the Download RA page, users can choose to download their 10 most current RAs.

If there is a banner message(s) for an RA, users can click the button in the Banner Messages
column to view the message(s).

2. Click the row of the RA the user wishes to download. In the “Select an RA section to
download” section, the All box is checked by default. The entire RA will be downloaded if this
option is checked.

4 Download Remittance Advices in a Comma-Separated
Values Report Format 15
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3. To download parts of the RA, the user can uncheck the All box and check the box for the

parts of the RA they wish to download.

Remittance Advices

RA Number RA Date Check/EFT Number Banner Messages
311952 06/22/2010 000000000 M
311700 05/17/2010 000000000

311683 05/13/2010 000055667

311590 05/03/2010 000055611

311028 03/08/2010 000055383

310926 02/25/2010 0D0D055332

310882 02/19/2010 000055319

Select an RA section to download:

W#MWW%WWW

[l Al ¥ summary [[Imedicare Crossover - Professional Claims
[Clpayment [#]Inpatient Claims [[IMedicare Crossover - Institutional Claims
[[] Payment Hold [¥| outpatient Claims [“] compound Drug Claims
[[Iservice Codes [C Professional Service Claims [[|Drug Claims
[CIFinancial Transactions [C|Long Term Care Claims [ Dental Claims
Submit Cancel

Figure 19 Remittance Advices and Select an RA Section to Download Sections

4. Click Submit. The File Download window will be displayed.

Do you want to open or save this file?

[f;' MName: 311700.csv
I d, .

Type: Microsoft Office Excel Comma Separated Values ...
From: 192.57.192.139

Cpen ][ Save ][ Cancel J

ham your computer. f you do not trust the source, do not open or

l@ While files from the Intemet can be useful, some files can potentially
L.
= save this file. What s the risk?

Figure 20 File Download Window

4 Download Remittance Advices in a Comma-Separated

Values Report Format 16
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5. Click Open. The CSV text file will be displayed in Excel.
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File Home Insert Draw Page Layout Formulas Data Review View Help Acrobat 1% Share - Comments
L‘Qﬁ A Calibri NP o A A = = E ?\g/,v 53 General v ﬁConditmmal Formatting ﬁln:ert v - évv
o E@ - $ -~ % L] @Furmat as Table ~ EDElEtE - - ,O -
- < Iy~ O A~ <1 o [ Cell Styles ~ [l Format~ | & ~
Clipboard R Font ] Alignment ] Mumber ] Styles Cells Editing Sensitivity N
Al = fo | RA# -
A B C D B [F G H | J K L M N Q P -
1 [RA# 1) 10 Check/EF Payment Payor NPI PayeeID Payee Typ Provider | Provider. Provider. Provider Provider! Provider Zip Code
2 2279203 10 74637 02{23{20: TXIX 1.79E+09 11022000 MCD UNIVERSI DRAWER . CLINICS A MILWAUEK WI 53278-0001
3 |RAH 30 SVC Code Description
4 | 2279203 30 J7301 SKYLA, 13.5 MG
5 2279203 30 110 ROOM & BOARD - PRIVATE GENERAL CLASSIFICATION ROOM-BOARD/PVT
6 | 2279203 30 111 ROOM & BOARD - PRIVATE MEDICAL/SURGICAL/GYN MED-SUR-GY/PVT
7| 2279203 30 120 ROOM & BOARD - SEMI-PRIVATE TWO BED GENERAL CLASSIFICATION ROOM-BOARD/SEMI
8 | 2279203 30 121 ROOM & BOARD - SEMI-PRIVATE TWO BED MEDICAL/SURGICAL/GYN MED-SUR-GY/2BED
9 | 2279203 30 306 LABORATORY BACTERIOLOGY & MICROBIOLOGY LAB/BACT-MICRO
10| 2279203 30 762 SPECIALTY SERVICES - OBSERVATION HOURS (A) OBSERVATION
11| 2279203 30 814 ACQUISITION OF BODY COMPONENTS UNSUCCESSFUL ORGAN SEARCH - DONOR UNSUCCESSFUL SEARCH
12| 2279203 30 88305 TISSUE EXAM BY PATHOLOGIST
13 |[RA# 40 ICN Claim Sta' Detail #  Member | Member | Member | PCN MRN Adjustme From DOS ToDOS  Covered | Admit Da DRG code SO
14 |[RA# 40 ICN Claim Sta' Detail #  Member | Member | Member | PCN MRN Adjustme Previous From DOS ToDOS  Covered [ Admit Da DR
15 |[RA# 40 ICN Claim Sta' Detail # Member | Member | Member | PCN MRN Adjustme Rev Code From DOS ToDOS  Allowed | PA Numb Bill
16| 2279203 40 2.22E+12 P 0 OLIVAS  CXTQUAM 9.01E+09 N 12/26/207 12/27/20: 40 12/26/202 724
17| 2279203 40 2.22E+12 P 1 OLIVAS  CXTQUAM 9.01E+09 N 111 12/26/20: 12/27/20: 1
18| 2279203 40 2.22E+12 P 0 OLIVAS CXTQUAMN 9.01E+03 N 01/02/20: 01/03/20: 1 01/02/20: 724
19| 2279203 40 2.22E+12 P 1 OLIVAS  CXTQUAM 9.01E+09 N 110 01/02/20: 01/03/20% 1
20| 2279203 40 2.22E+12 P 0 OLIVAS  CXTQUAN 9.01E+09 N 01/21/20: 01/22/20: 1 01/21/20: 724
21| 2279203 40 2.22E+12 P 1 OLVAS CXTQUAMN 9.01E+09 N 110 01/21/20% 01/22/20: 1
22 | 2279203 40 2.22E+12 P 0 OLIVAS CXTQUAM 9.01E+09 N 02/02/20: 02/03/20: 1 02/02/202 53
23| 2279203 400 2.22E+12 P 1 OLIVAS  CXTQUAM 9.01E+09 N 123 02/02/20: 02/03/20: 1 &lx
2279203 4 3
Ready @ Cgl Display Settings is2) m - 1 + 100%

Figure 21 CSV Text File

Certain columns may show scientific notation in place of long numbers such as internal
control numbers. To correct this:

a. Click a column header to highlight the column.

4 Download Remittance Advices in a Comma-Separated
Values Report Format 17



ForwardHealth Provider Portal Remittance Advice User Guide

March 11, 2024

b. Under the Home menu item, click the Number Format dialog box (represented by a

diagonal arrow in the corner).

Oraw Pagelayot  Formelas  Data Reveew View  Melp  Acobat 2 Shave & Comeents
] Z AvtoSem = A
o E gy 888 2w v 0
$ -9 9 A f Cosdtons Fumsm Ceb | lowen Ociese Foomat | Son & Fend &
¢ " Fomattiog = Tebe = Stjles - . v . © Cne = Fiter = Sedect =
% Nmags e Com tarny Senctaty -
a v
4 A " ' ) x L M N o » Q 3 s ¥ -
1 |ran 10| Check/EFT Number | Payment Payor N9 PayeelD Payee Ty) Provider | Provider . Provider . Provider « Provider | Provider Dp Code
2| 2o 1 4637 02/23/20; TXIX L7960 11022000 MCD  UNIVERSI DRAWER CUNICS A MILWAUS Wi $3278.0001
3 [raw 30 SVC Code Description
4| 2m 30 /7303 [sona, 135 MG
3| 2 ) 30| ROOM & BOARD - PRIVATE GENERAL CLASSIFICATION ROOM-BOARD/PVT
6| 209 % 221{ KOOM & BOARD - PRIVATE MEDICAL/SURGICAL/GYN MED-SUR-GY/PVT
7| 27 » 120| ROOM & BOARD - SEMI-PRIVATE TWO BED GENERAL CLASSIFICATION ROOM-BOARD/SENI
8| 27908 ) 221{ ROOM & BOARD - SEMS-PRIVATE TWO B0 MEDICAL/ SURGICAL/GYN MED-SUR-GY/2860
8| 2 b 306| LABORATORY BACTERIOLOGY & MICROBIOLOGY LAR/BACT-MICRO
10| 2279208 » 263| SPECIALTY SERVICES - OBSERVATION HOURS (A) OBSERVATION
1| 2mo e B8] ACQUISITION OF BOOY COMPONENTS UNSUCCESSFUL ORGAN SEARCH - DONOR UNSUCCESSFUL SEARCH
12| 2m08 L BE308| TISSUE EXAM BY PATHOLOGIST
Hrae 0l KN Claim St Detadl @ Member | Member | Member | PON MEN Agpastme From DO! ToDOS  Covered | Admt Da DRG code S04 Billed Arr Alowed + Othes bns Spd
4w 40 KN Claim Sta OWtail @ Member | Member | Member | PON MEN  Adjustme Previous FromDOf ToDOS  Covered | Adewt Da DRG code SO¢ Billed A Aliowed + Ott
1Blrae 0 KN | Cleim Sts Detail @ Member | Member | Member | PON MEN Adpustme Rev Code From DOt TODOS  Allowed | PA Numb Billed A Allowed « Paid Amt Detad EOBS
18] 22703 4 2226002| » 0 OUVAS  CXTQUAN 9.016+09 . 12/26/20; 32/27/20% 40 12/26/20% ™ ] 10 100 s
1| 2mm & 222602 1 OUVAS  CXTQUAN 9.01E+9 ~ 101 22/20/20: 12/27/20% 1 %0 wo o wn
18] 270 0 220002 » 0 OUVAS  CXTQUAN 9.016+09 N ©1/02/20; 01/03/20; 1 N0/ ™ 1 100 10 s
W] 2o « 2226012 » 1 OUVAS  CXTQUAN 9.016+9 N 110 01/02/20; OU/ON20% 1 100 w0 o »n
0] 270 0 2226002(» 0 OUVAS  CXTQUAN 9.016+9 ~ 01/24/20; 01/22/20; 1 oya/; » 1 M0 o s
| 2o « 2226002| > 1 OUVAS  CXTQUAN 9.016409 ~ 110 OL/21/20; OV/22/20% 1 T®O 70 o »r
2| 2o 0 2220022| 0 OUVAS  CXTQUAN 9.016+09 N 02/02/20; 02/03/20 1 02/02/200 3 2 san  sn °
| 20 L 220602| » 1 OUVAS  CXTQUAN 9016+ N 123 02/02/20; 0/ON/20% 1 “n unn o wn
2| 270 « 222602 » 2 OUVAS  OXTQUAN 9.01E+09 ~ 306 02/02/20; 02/03/20% 1 20 20 o #n
3| 20 < 2220e02| > 3 OUVAS  CXTQUAN 901649 . 40 02/02/20: 0/ON20% 2 s Yms 0o W .
1210 + 0 .
ey W Average LISTIES1Z  Count €7 Sum 535530e1) (Gowpimsenegs B W B - 1 . 00N
Figure 22 CSV Text File Number Fix
Format Cells ? X
Mumber Alignment Font Border Fill Protection
Category:
General Sample
Number Check/EFT Number
Currency
Accounting Type:
Date 2717
Time ik
Percentage $2 220,00 (5 220.00) ~
Fraction §2 #20.00 ) [Red]($2 #20.00)
Scientific 0%
Text 0.00%
Specal 0.00E+00
TR | | --ooc0
FEE
m/d/yyyy
d-mmm-yy
d-mmm
mmm-yy el
Delete
Type the number format code, using one of the existing codes as a starting point.
e

Figure 23 Number Format Dialog Box
d. Select # ?/? in the Type section.

e. Click OK. Once expanded, all columns with long numbers should now appear correctly.
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7. Click Save As under the File menu item to save the CSV text file.
Note: The user must first save the CSV text file to properly download and format the data
content as a spreadsheet document.

Favorite Links Size Date modified

E| Documents '-&l‘ Computer l Public
Mare » - '

Folders T
h Netwark
e

4 Ml Desktop

File name:  311700.csv

Save as type: | Microseft Office Excel Comma Separated Values File

= Hide Folders

Figure 24 Save As Window
8. Choose a location on the computer or network to save the RA CSV text file.

9. Click Save.

4.1 Format the Comma-Separated Values File

To properly read the CSV text file after it has been saved, the user will need to first import the
text file into a spreadsheet or database program and then format it. The examples shown here
use the Excel spreadsheet program.

1. Open a blank spreadsheet.
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In the menu bar at the top of the screen, click Data. The Data menu will be displayed.

File Home Insert Draw Page Layout Formulas Review View Help Acrobat 4 Share 2 Comments
[;1 My From Teaxt/CsV ll [ Recent Sources ™ (B Quenies & Connections | & E <7 = &8 & E3 [; q | 9BGroup
y z4 |A \ y B - = X
~ET0 Trom Web [P Existing Connections = = bl $Bungroup ~
Get Refresh Z| Sent Fiter Tatto ~ What-if Forecast |
Data ~ £ From Table/Range Al ~ et YeAdvanced | Columns €6 © M) | Anshis~  Sheet &8 subtotal
\
Get &Transform Data Queries & Connections Sort & Futer Data Tools Forecast Outhine 5 A
Al S v
A 8 C 0 E F G H 1 ) K L M N o 4 Q -
1 —_—
.
2
3
4
5
6
7
8
9
10
n
12
13 v
Sheet! + ‘ »
rRasy B (3 Display Settings B B O - ] + 100

Figure 25 Blank Spreadsheet

3. Click From Text/CSV located on the left side of the Data menu. The Import Data window will

open.

u Import Data

Organize ~

= This PC

B 3D Objects
I Desktop

*| Documents
¥ Downloads
I Music
&= Pictures
i Videos
4.4 OSDisk (C)

New folder

- Name

B 2279203

v

File name: | 2279203

1 Bl > ThisPC > OSDisk(C) » Users » waxfsS »

Desktop

_

Microsoft Excel Co...

43 KB

| |Text Files ~

Cancel

Figure 26 Import Data Window

4. Navigate to the location where the user saved the CSV file and select the file.
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5. Click Import. The data capture window will be displayed.

X
2279203 .csv
File Origin Delimiter Data Type Detection
1252: Western European (Windows) ~ Comma v Based on first 200 rows v .:,
Column1 Column2 Column3 Column4 Column5 Column6 Column7 Column8
~
RAH 10 | Check/EFT Number Payment Date Payor NPI Payee ID Payee Type | Provid:
2279203 10 74637 02/23/2022 THIX 1790720985 11022000 MCD UNIVEI
RAH# 30 | SVC Code [kescription
2279203 30 17301 SKYLA, 13.5 MG
2275203 30 110 ROOM & BOARD - PRIVATE GENERAL CLASSIFICATION R...
2279203 30 111 ROOM & BOARD - PRIVATE MEDICAL/SURGICAL/GYN M...
2275203 30 120 ROOM & BOARD - SEMI-PRIVATE TWO BED GENERAL C__
2275203 30 121 ROOM & BOARD - SEMI-PRIVATE TWO BED MEDICALS...
2279203 30 306 LABORATORY BACTERIOLOGY & MICROBIOLOGY LAB/B...
2279203 30 762 SPECIALTY SERVICES - OBSERVATION HOURS {A) OBSER...
2279203 30 Bl4 ACQUISITION OF BODY COMPONENTS UNSUCCESSFUL...
2275203 30 B8305 TISSUE EXAM BY PATHOLOGIST
RA# 40 | ICN Claim Status Detail # Member Last Name | Member First Name | Member No | PCN
RA# 40 ICN Claim 5tatus Detail # Member Last Name Member First Name  Member No | PCN
RA# 40 | ICN Claim Status Detail # Member Last Name | Member First Name | Member No | PCN
2279203 40 2222050000000 P 0 OLIVAS CXTQUANTITYEX 9010005836
2275203 40 2222050000000 P 1 OLIVAS CXTOUANTITYEX 9010005836
2279203 40 2222050000000 P 0 OLIVAS CXTQUANTITYEX 9010005836
2279203 40 2222050000000 P 1 OLIVAS CXTQUANTITYEX 9010005836
2279203 40 2222050000000 P 0 OLIVAS CXTQUANTITYEX 9010005836 V]
< >
renstomoeta | | cance
Figure 27 Data Capture Window
Keep the default File Origin, Delimiter, and Data Type Detection values, as shown.
Click Load. The final imported file will be displayed.
file ~ Home Inset Draw  Pagelayout  Formulas  Data  Review View Help  Acrobat  TableDesign  Query 8 Share 3 Comments
Table Name: Summarize with PivotTable [ [&] Properties | HeaderRow | | First Column [~ Filter Button -
5] =
%279203 B} Remove Duplicates % E?i RE% B Total Row Last Column ;
‘B Resize Table | (1 Convert to Range Slicer v v S Unlink ~ Banded Rows | | Banded Columns
Properties Tools External Table Data Table Style Options Table Styles ~
AL N F 9
A 8 c D E -
1 B3 columnz B column3 olumn4
2 [RaE 10 check/EFT Number Payment Date
3 2279203 10 74637 02/23/2022
4 RAE 30 SVCCode Description
5 12279203 30 47301 SKYLA, 13.5 MG
6 2279203 20 110 ROOM & BOARD - PRIVATE GENERAL CLASSIFICATION ROOM-BOARD/PVT
7 2279203 30 111 ROOM & BOARD - PRIVATE MEDICAL/SURGICAL/GYN MED-SUR-GY/PVT
& 2279203 30 120 ROOM & BOARD - SEMI-PRIVATE TWO BED GENERAL CLASSIFICATION ROOM-BOARD/SEMI
9 12279203 30 121 ROOM & BOARD - SEMI-PRIVATE TWO BED MEDICAL/SURGICAL/GYN MED-SUR-GY/2BED
10 2279203 30 206 LABORATORY BACTERIOLOGY & MICROBIOLOGY LAB/BACT-MICRO
112279203 30 762 SPECIALTY SERVICES - OBSERVATION HOURS (A} OBSERVATION
12 2279203 30 814 ACQUISITION OF BODY COMPONENTS UNSUCCESSFUL ORGAN SEARCH - DONOR UNSUCCESSFU
13 2279203 30 88305 TISSUE EXAM BY PATHOLOGIST
14|RAE 40 ICN Claim Status Detail #
15 RA# 40 ICN Claim Status Detail #
16 |RA # 40 ICN Claim Status Detail #
17 2279203 40 2222050000000 P [
18 2279203 40 2222050000000 [ 1
19 2279203 40 2222050000000 [ 0
20 2279203 40 2222050000000 [ 1
212279203 40 2222050000000 P [
22 2279303 40 2222050000000 [ 1
23 2279203 40 2222050000000 [ 0
242279203 40 2222050000000 [ 1
25 2279203 40 2222050000000 P 2 -
[ 2279203 | sheett | @ . v
Ready @ g Display Settings B B - 1 + 100%

Figure 28 Final Imported RA File
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8. Save the formatted file. Saving before making changes will help to avoid having to convert
the CSV file again should the user encounter problems while working with the data.
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5 View Explanation of Benefits Codes
and Descriptions

1. Onthe Remittance Advices page, click View EOB codes and descriptions in the “Comma-
Separated-Values Format (.csv)” section.

the

Comma-Separated-Values Format (.csv)

Use the following links to access remittance advices in CSVY format. Users will be able to select
which specific RA they would like to download. Users will also be able to choose which sections of

advices will be available in CSV format.

RA they would like to include in the download file. A provider or MCOs last 10 remittance

Download remittance advices in a CSW {.csv) report format

View the RA User Guide

View the CSV file User Guide

View EQB codes and descriptions

Figure 29 Comma-Separated-Values Format (.csv) Section

The Explanation of Benefits Code Listing page will be displayed.

EOB
Code

0000
0001
0002
0003
0004
0005
0006

0007

0oos
0009
0010
0011
0012
0013
0014
0015
0016

Explanation of Benefits Code Listing

An Explanation of Benefits (EOB) code corresponds to a printed message about the status or action taken on a claim. Providers will find a
list of all EOB codes used with the corresponding description on the last page of the Remittance Advice.

0017 |The Evaluation Was Received By ForwardHealth Fiscal Agent More Than Two Weeks After The Evaluation Date.

EOB Description

This claim/service is pending for program review.

Member's ForwardHealth I.d. Number Is Missing Or Incorrect

ForwardHealth Number On Claim Does Not Match ForwardHealth Number On Prior Authorization Request.
A minimum of one detail is required.

DME rental beyond the initial 30 day period is not payable without prior authorization.

Charges Paid At Reduced Rate Based Upon Your Usual And Customary Pricing Profile.

Amount Paid Reduced By Amount Of Other Insurance Payment.

Information inadequate to establish medical necessity of procedure performed.Please resubmit with additional supporting
documentation.

The Number Of Weeks Has Been Reduced Consistent With Goals And Progress Documented.

Member Name Missing. Please Correct And Resubmit.

Member is enrolled in Medicare Part A and/or Part B on the on the Dispense Dateof Service.

Medicare Part A Services Must Be Resubmitted. Please Attach Copy Of Medicare Remittance.

Service Paid At The Maximum Amount Allowed By ForwardHealth ReimbursementPolicies.

Dollar Amount Of Claim Was Adjusted To Correct Mathematical Error.

A discrepancy exists between the Other Coverage Indicator and the Other Paid Amount.

Pediatric Community Care is limited to 12 hours per DOS.

Drug Dispensed Under Another Prescription Number. Multiple Prescriptions For Same Drug/ Same Fill Date, Not Allowed.

Figure 30 Explanation of Benefits Code Listing Page
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2. Scroll to the EOB code the user wishes to view.
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